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Introduction 
This document provides detailed information on installation procedure and detailed functionalities of 
the Fuji Xerox Connect to: Installer (v1.0) for SharePoint Online. 

Overview 
The Fuji Xerox Connect to: Installer (v1.0) for SharePoint Online is designed to be an all-purpose 
application that helps in discovering compatible Fuji Xerox multifunction devices (MFDs) on the 
network and then installing, uninstalling and upgrading Connect to: plug-ins on the MFDs. The 
installer also works as a single point to manage the number of MFDs, maintain version control of 
plug-ins and apply licensing to the installed plug-ins. 

After installing or updating the Connect to: plug-ins successfully on the MFD through Connect to: 
Installer for SharePoint Online, users can use it on the MFD. 

Help Desk 
If you require further assistance, please contact Fuji Xerox Australia Customer Support Centre on: 

1800 028 962 
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Prerequisites for Connect to: for SharePoint Online 
Microsoft .NET Framework 4.0 must be installed on the machine on which the Connect to: for 
SharePoint Online runs. 

The application can run on the following Operating Systems: 

• Windows Server 2003 (32/64 bit) 
• Windows Server 2008 (32/64 bit) 
• Windows Server 2008 R2 
• Windows Vista (32/64 bit) 
• Windows 7 (32/64 bit) 
• Windows 8 (32/64 bit) 

The application requires the Fuji Xerox MFDs to have SSMI version 1.17.2 or higher installed on them 
and XCP plug-in kit version 1.3.1 or higher enabled. 

• Following is the list of Fuji Xerox MFDs on which the application can run: 
o ApeosPort IV 2275/3373/3375/4475/5575 
o ApeosPort IV 6080/7080 
o ApeosPort V C3373 (T2)/C3375 (T2)/C4475 (T2)/C5575 (T2)/C6675 (T2)/C7775 (T2) 
o ApeosPort V C5580 (T2)/C6680 (T2)/C7780 (T2) 

 
Note: The installer does not work on DocuCentre. 

 

For information on how to configure Connect to: for SharePoint Online shortcut on MFD All Services 
screen, refer to Appendix A. For information on how to check SSMI version, refer to Appendix B. For 
information on how to check if XCP plug-in is enabled or not, refer to Appendix C. For information on 
how to change the log file path, refer to Appendix D. 
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How to Install Connect to: Installer for SharePoint 
Online 
To install Connect to: Installer for SharePoint Online: 

1. Right-click the Connect to for SharePoint Online.exe and select Run as administrator. 

 

 
Figure 1 
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The InstallShield Wizard screen is displayed. 

 

 
Figure 2 

 

2. Click Next. 

The Licence Agreement screen is displayed. 
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3. Select I accept the terms in the licence agreement and click Next. 

 

 
Figure 3 

 

The following screen is displayed: 

 

 
Figure 4 
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4. Click Install to begin the installation. 

The InstallShield Wizard Completed screen is displayed. 

 

 
Figure 5 

 

5. Click Finish to exit the wizard. 
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User Help for Connect to: Installer for SharePoint 
Online 
This section provides information on the following topics: 

• How to Discover MFDs 

• How to Install Plug-ins on MFDs 

• How to Uninstall Plug-ins from MFDs 

• How to Upgrade Plug-ins on MFDs 

• How to Apply Licence for Plug-ins 

• How to Repair Plug-ins on MFDs 

• Troubleshooting 
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How to Discover MFDs 
This section describes the user interface of the Connect to: Installer for SharePoint Online and 
explains how to search MFDs. 

To search MFDs: 

1. Type the common device Admin credentials (Administrator ID and Password) in the 
corresponding fields displayed on the Connect to: Installer for SharePoint Online home page: 

 

 
Figure 6 
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Note:  

• Click File > Exit to exit the application. 
• Click Help > View Help to access the Fuji Xerox Connect to: Installer for 

SharePoint Online help. Alternatively, you can press F1 to access the help. 
• Click Help > About to view the following screen with version details: 

 

 
Figure 7 

When required, please share the Package Version details with the Fuji 
Xerox Australia Customer Support Centre. 

 

2. Select the appropriate search criteria from the dropdown list as shown in the screenshot 
below: 

 

 
Figure 8 

 

You have the following two search options available for device discovery: 
 Single Device 
 Range of Devices  
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Single Device search 
To start Single Device search: 

1. Select Single Device from the Device dropdown list. 

 

Note: Single Device is the default selection in the Device dropdown list. 

 

2. Type the IP address in the IP Address field and click Search: 

 

 
Figure 9 

 

Note: The first three parts of the IP address is auto-populated with the 
IP address of the machine on which the Installer runs. 
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The following device search progress screen is displayed: 

 

 
Figure 10 

 

Note: Click Cancel on the device discovery search screen if you want 
to stop the search. 

 

After the search is complete, the following screen with MFD details is displayed: 

 

 
Figure 11 

 

Note:  

• If no device is found, then a message Device not found is displayed. 

• If no compatible device is found, then a message Compatible device(s) 
not found is displayed.  
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• If a user provides wrong credentials for an MFD, the IP Address and the 
Install button are displayed, and either of the following two messages 
are updated in the log files: 

 Invalid MFD username or password 
 System is Locked 

[This note is also applicable for the Range of Devices search section.] 

 

The search results display the following data in different columns: 
 IP Address: Displays the IP address of the device. The hostname is also displayed 

under the IP address. 
 Installed On: Displays the date on which the plug-in is installed 
 Version: Displays the version details of the installed plug-in. 
 Licence Key: Displays the expiry date of the trial licence and the exact number of 

days remaining before its expiry. Also displays the Apply Licence link whenever 
applicable.  

Range of Devices search 
To search multiple devices within a specific range of IP addresses: 

1. Select Range of Devices from the Device dropdown list. 

2. Type the start range of the IP address in the From IP Address: field and end range of the IP 
address in the To IP Address: filed and click Search. 

 

 
Figure 12 

 

Note: The first three parts of the IP address in both the fields are auto-populated 
with the IP address of the machine on which the Installer runs. 
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The following device search progress screen is displayed: 

 

 
Figure 13 

 

Note: Click Cancel on the device discovery search screen if you want to 
stop the search. 

 

After the search is complete, the following screen with device details is displayed: 

 

 
Figure 14 
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How to Install Plug-ins on MFDs 
To install plug-ins and CSS files on an MFD: 

1. Search the MFDs on which you want to install the plug-in and CSS file, using the procedures 
explained in How to Discover MFDs. 

The search results are displayed: 

 

 
Figure 15 

 

Note: The Install button is displayed only for those devices on which 
the plug-in and CSS file are yet to be installed. 
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2. Click Install to install the plug-in and CSS file on the corresponding device. 

 

Note 1: If you force close the application (by clicking the X button at the 
top-right corner of the screen) at any point of time during installing, 
uninstalling or upgrading the plug-ins, the following screen with a warning 
message is displayed. Clicking Yes may leave the MFD in error state. 

 

 
Figure 16 

 

Note 2: While installing, uninstalling, upgrading or repairing the plug-ins, if 
either the device is simultaneously in operation by a different user or there is 
movement in front of the device, causing it to wake up from power save 
mode, the following error message displayed on the screen: 

 

 
Figure 17 
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How to Uninstall Plug-ins from MFDs 
To uninstall plug-ins and CSS files on an MFD: 

1. Search the MFDs from which you want to uninstall the plug-ins and CSS files, using the 
procedures explained in How to Discover MFDs. 

The search results are displayed: 

 

 
Figure 18 

 

Note: The Uninstall button is displayed only for those devices on which 
the plug-in and CSS file have already been installed. 

 

2. Click Uninstall to uninstall the plug-in and CSS file from the corresponding device. 
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How to Upgrade Plug-ins on MFDs 
To upgrade the plug-ins and CSS files on an MFD: 

1. Search the MFDs on which you want to upgrade the plug-in or CSS file, using the procedures 
explained in How to Discover MFDs. 

The search results are displayed: 

 

 
Figure 19 

 

Note: If a different version of installer, CSS or XCP plug-in is available for the 
Connect to: for SharePoint Online, the Upgrade button is displayed. 

 

2. Click Upgrade to update the plug-in and CSS file on the corresponding MFD either to the 
higher or to the lower version. 
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How to Apply Licence for Plug-ins 
This section provides information on how to activate a licence for Connect to: plug-ins installed on 
MFDs. 
 
To apply licence for plug-ins on MFDs: 

1. Follow the steps explained in How to Discover MFDs to search the MFDs on which you want 
to apply licence for the plug-in installed. 

The search results screen is displayed: 

 

 
Figure 20 

 

2. Search through the Licence Key column to find the MFDs for which the licence either has 
expired or is in its trial period. 

3. The Apply Licence hyperlink is displayed for those plug-ins (on the MFDs), whose trial period 
still exists or has expired. If trial period exists, following information is displayed in the 
Licence Key column: 

o Expiring on: <date> 
o Days remaining: <number of days> 

If trial period is over, the message Expired on <date> is displayed along with Apply Licence 
hyperlink. 
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4. Click Apply Licence. 

The following screen is displayed: 

 

 
Figure 21 

 

5. Type a valid licence key in the Please enter licence key field and click Apply. 

 

Note: To obtain a perpetual licence for the Connect to: for SharePoint Online, 
please visit the Fuji Xerox Australia website and follow the prompts under the 
Connect to: for SharePoint Online micro-site. 

 

A confirmation screen like the following is displayed: 

 

 
Figure 22 

  

http://www.fujixerox.com.au/
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6. Click Close after the licence is applied. 

The associated record is refreshed with the latest licensing information (Perpetual in the 
following screenshot) in the Licence Key column. 

 

 
Figure 23 

 

How to Repair Plug-ins on MFDs 
This section provides information on how to repair Connect to: plug-ins installed on MFDs. 

1. If either the plug-in or the CSS files are missing in the MFD, you can see the Repair button 
while discovering it: 

 

 
Figure 24 
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2. Click Repair to send the plug-in or the CSS files to a consistent state. (It might take a few 
minutes to complete this action.) 

The following screen is displayed: 

 

 
Figure 25 

 

3. After the repair is complete, a confirmation screen like the following is displayed: 

 

 
Figure 26 
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Troubleshooting 
This section lists a few problems that users might face while working with the Connect to: Installer for 
SharePoint Online and their probable solutions. 

 

Problem: If there are issues related to compatibility, what should I do? 

Solution:  

Check the SSMI version of the MFD.  

For information on how to check the SSMI version of an MFD, refer to Appendix B. 

 

Problem: If upgrade/install/uninstall fails, what should I do? 

Solution:  

Restart the MFD and retry the operation. If problem persists, the device might be in error state. Please 
contact Technical Support for assistance. 

 

Problem: If applying licence fails, what should I do? 

Solution:  

Please contact Technical Support to ensure that you have a valid licence. 

 

Problem: In case of ‘Device not found’ errors, what should I do? 

Solution:  

• Check if the FXA-K1SDK.pfx security certificate is installed in Microsoft Management 
Console. 

• Check if the MFD is in the network and accessible by using a web browser to access the 
MFD's CentreWare Internet Services (CWIS). See Appendix B for information on how to 
access MFD’s CWIS. 

• Check if the proxy settings are enabled for your web browser. If they are enabled, add the 
MFD IP address in the Exceptions list for Proxy Settings of the Internet Options. 

 

Problem: If the application doesn’t work, what should I do? 

Solution:  

Ensure that the security certificates for the application are installed. 

 

Problem: My trial licence has expired. How should I renew it?  

Solution:  

Licences available for this application are of two types, trial and perpetual. A trial licence is valid for 
30 days and it expires after that period. A perpetual licence is valid forever and it never expires. 

If your trial licence has expired, you must contact Technical Support for a valid perpetual licence to 
use the application. 
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Problem: If I don’t have the Admin rights to an MFD, what does this mean? What should I do? 

Solution:  

Admin rights are the credentials which are used to do any operation (such as get plug-in details, 
install plug-in, uninstall plug-in or upgrade plug-in) on an MFD. The default admin credentials are: 

• Username: 11111 

• Password: x-admin 

Please contact your System Administrator to get the Admin rights. If required, please contact 
Technical Support. 
 

Problem: What should I do when I have started searching for devices but the search results are 
not displayed? 

Solution:  

Following might be a few possible reasons: 

• Improper credentials provided during search 

• Network failure 

• Incompatible devices (i.e. SSMI version is not 1.17.2 or higher) 

• XCP plug-in is not active 

Ensure that the above issues are addressed. If the problem persists, please contact Technical Support. 

 

Problem: What should I do if I get the message 'Unable to retrieve Plug-in information'? 

Solution:  

Restart the specific MFD and search again. If problem persists, please contact Technical Support. 

 

Problem: What should I do if I get the message 'Unable to retrieve Licence information'? 

Solution: 

This message is displayed when plug-ins are pushed to or removed from the MFD, but the MFDs are 
yet to reboot for activation or deactivation. So wait for a few minutes and try to search the device 
again. If problem persists, open the CWIS and check for the state of the plug-in in the MFD. 

 

Problem: What should I do if I get the message 'System is Locked'? 

Solution: 

This message is displayed when wrong Administrator ID or Password is entered more than five times 
consecutively. Please reboot the MFD and enter the correct credentials. 
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Problem: What should I do if I get this message 'Unable to retrieve information as Plug-in is in 
reboot to activate state'? 

Solution: 

This message is displayed when the plug-ins are pushed to the MFD, but the MFD is yet to reboot for 
activation. So, open the CWIS and click Reboot Machine from the Status tab. Alternatively, you can 
repair the plug-in using the procedure explained in the How to Repair Plug-ins on MFDs section. 
 

Problem: What should I do if I get the message 'Unable to retrieve information as Plug-in is in 
reboot to deactivate state'? 

Solution: 

This message is displayed when the plug-ins are removed from the MFD but the MFD is yet to reboot 
for deactivation. So, open the CWIS and click Reboot Machine from the Status tab. Alternatively, you 
can repair the plug-in using the procedure explained in the How to Repair Plug-ins on MFDs section. 

 

Problem: What should I do if I get the message 'Plug-in Settings option is not enabled on the 
MFD'? 

Solution: 

This message is displayed when the plug-in settings are not enabled on the MFD. So enable the plug-
in settings through CWIS tool and search the device. For more information on plug-in settings, refer 
to Appendix C. 

 

Problem: I have installed the latest version of Connect to: Installer for SharePoint Online on my 
laptop. During device discovery, the error ‘Device not found’ message is displayed. What should I 
do? 

Solution: 

This might happen if any other application uses the port 15191, which is the default port used by 
Connect to: Installer for SharePoint Online. This default port cannot be modified. 
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Appendix A ---- How to Configure Connect to: for 
SharePoint Online Shortcut on MFD All Services Screen 

1. Touch the Log In / Out button on the MFD Control Panel. 

 

 
Figure 27 

 

2. Touch the Log in as Administrator button. 

 

 
Figure 28 

 

3. If you do not see the screen as shown in Step 2, proceed with Step 4. 
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4. The Log in as System Administrator dialogue is displayed. 

 

 
Figure 29 

 

5. Type the Admin’s Login ID and touch Enter. 

The All Services screen is displayed with Admin logon. 

 

 
Figure 30 

 
  



 

Connect to: Installer for SharePoint Online v1.0 User Guide Page 31 

6. Touch the Tools button. 

The Tools screen is displayed. 

 

 
Figure 31 

 

7. From the Features menu on the right, touch Screen/Button Settings…. 

The Screen / Button Settings screen is displayed. 

 

 
Figure 32 
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8. Scroll down till you see Services Home in the Items column and touch it. 

9. Touch Change Settings. (Refer to Figure 32.) 

The Services Home screen is displayed. 

 

 
Figure 33 

 

10. Touch the corresponding button position number where you want the Connect to: for 
SharePoint Online shortcut to be displayed.  

11. Scroll down and select Connect to: for SharePoint Online. 

 

 
Figure 34 
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12. Touch Save. 

The Services Home screen is displayed. (Refer to Figure 33.) 

13. Touch Save. 

The Screen / Button Settings screen is displayed. (Refer to Figure 32.) 

14. Touch Close. 

The Tools menu is displayed.  

 

 
Figure 35 

 

15. Touch Close. 

The All Services screen is displayed. The Connect to: for SharePoint Online shortcut is 
created in the specified position. 

 

 
Figure 36 
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You may need to browse the pages to locate the shortcut. 

 

 
Figure 37 

 

16. Touch the Log In / Out button to exit Admin mode.  
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Appendix B ---- How to Check the SSMI Version of an 
MFD 
To check the SSMI version of an MFD: 

1. Browse the IP address of the MFD on a web browser. 

2. Click the Properties tab. 

3. Click General Setup in the left pane and then click Configuration. 

 

 
Figure 38 

 

4. Scroll down to the Software section. 

You can find the SSMI version details. 
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Appendix C ---- How to Check If XCP Is Activated and 
Enabled 
To check if XCP Plug-in is activated and enabled on the MFD: 

1. Browse the IP address of the MFD on a web browser. 

2. Click the Properties tab. 

3. Click General Setup in the left pane and then click Security. 

4. Scroll down and click the Plug-in Settings node. 

 

Note: The Plug-in Settings node is visible only when XCP plug-in is activated. 

 

If the plug-in is enabled, the following screen is displayed with Enabled checkbox selected: 

 

 
Figure 39 
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Appendix D ---- How to Change the Log File Path 
To change the log file path: 

1. Browse the Connect to: for SharePoint Online application installation path. 

2. Open the FXA.OI.ESAC.Installer.exe.config file with Notepad. 

You can find the following two instances where the log file path is mentioned: 

• C:\Temp\FXA.OI.ESAC.log 

• C:\Temp\K1SDK.log 

3. Modify the path as per your requirement and save the file. 
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